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Copyright
No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of Digital Film Tools.

Copyright © Digital Film Tools, LLC. 2009. All Rights Reserved

August 1, 2009

About Us
Composite Suite Pro brings together the unbeatable combination of superior 

software designers, motion picture visual effects veterans, video editors and 

photographers. Add three Emmy Awards and experience in creating visual 

effects for hundreds of feature films, commercials and television shows and you 

have a recipe for success. The understanding of photography, film and video 

editing, and in particular visual effects, allows us to design productive and 

highly specialized software. Software that is useful as well as easy to use. Our 

products stand up to the rigors of production and are the culmination of many 

years of experience.

Our philosophy is to bring our visual effects tools and techniques to the 

masses. What was once found only in expensive high-end packages or existed 

as proprietary in-house tools, is now available to photographers, artists, 

designers, and video/film editors. Did I mention affordable? Our software 

doesn't cost an arm and a leg and won't break the bank.

About this Guide
This User Guide is a reference for Composite Suite Pro. You can read from start 

to finish or jump around as you please. This guide is available in On-Line help 

and Acrobat PDF format.
mposite Suite Pro User Guide
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 INSTALLATION

Adobe After Effects & Compatible Programs
1 Download Composite Suite Pro at www.digitalfilmtools.com

2 Double-click on the file that was downloaded and run through the installation 
process.

3 When prompted, select your application's plug-in folder. For After Effects, this is 
usually the Adobe\After Effects\Plug-ins folder.

4 Start After Effects or your After Effects plug-in compatible application.

5 Apply a Composite Suite Pro filter to a clip in the timeline from the Effects > DFT 
Composite Suite Pro pull-down menu.

6 When you apply one of the Composite Suite Pro filters, a dialog box pops up.

7 If you purchased the software, select Activate Composite Suite Pro and follow 
the instructions.

or 

8 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of Composite Suite Pro for the specified trial period. At 
the end of the trial period, Composite Suite Pro reverts to a limited demo mode.

or

9 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, dots are superimposed over the image.
Composite Suite Pro User Guide    
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Apple Final Cut Pro
1 Download Composite Suite Pro at www.digitalfilmtools.com

2 Double-click on the file that was downloaded and run through the installation 
process.

The default installation location is the /Library/Plug-ins/FxPlug folder.

3 When you start Final Cut Pro, a Composite Suite Pro dialog box pops up.

4 If you purchased the software, select Activate Composite Suite Pro and follow 
the instructions.

or 

5 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of Composite Suite Pro for the specified trial period. At 
the end of the trial period, Composite Suite Pro reverts to a limited demo mode.

or

6 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, dots are superimposed over the image.

7 You will find the filters located in the DFT Composite Suite Pro group within the 
Effects > Video Filters pull-down menu.
mposite Suite Pro User Guide
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Avid Editing Systems
1 Download Composite Suite Pro at www.digitalfilmtools.com

2 Double-click on the file that was downloaded and run through the installation 
process.

3 When prompted, select your AVX_Plug-ins folder. For Windows users, this is 
normally the C:\Program Files\Avid\AVX_Plug-ins folder. For Mac Users, this is 
usually the Media Composer\SupportingFiles\AVX_Plug-ins folder.

Note: For Mac users that have Avid editing systems other than Media Composers, the 
AVX_Plug-ins folder is usually located at “Your Avid 
System”\SupportingFiles\AVX_Plug-ins.

4 When you start your Avid editing software, a Composite Suite Pro dialog box 
pops up.

5 If you purchased the software, select Activate Composite Suite Pro and follow 
the instructions.

or 

6 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of Composite Suite Pro for the specified trial period. At 
the end of the trial period, Composite Suite Pro reverts to a limited demo mode.

or

7 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, dots are superimposed over the image.

8 You will find the filters located in the Composite Suite Pro effect group within the 
Effects Palette.
Composite Suite Pro User Guide    
• 
• 
•
•
•

http://www.digitalfilmtools.com/cs/download.htm


   Co

6 Uninstalling

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 UNINSTALLING

Windows
1 Click the Windows Start Menu

2 Select Programs > Digital Film Tools > Composite Suite Pro Version > Uninstall 
Composite Suite Pro

Macintosh

Adobe After Effects
1 Go to /Applications/Digital Film Tools

2 Remove the Composite Suite Pro AE folder

3 Go to /Applications/Adobe After Effects (version)/Plug-ins

4 Remove DFT Composite Suite Pro

Avid Editing Systems
1 Go to /Applications/Digital Film Tools

2 Remove the Composite Suite Pro Avid folder

3 Go to /Applications/Avid (version)/Supporting Files/AVX_Plug-Ins

4 Remove CompositeSuitePro.bundle

Apple Final Cut Pro
1 Go to /Macintosh HD/Library/Plug-ins/FxPlug

2 Remove DFT Composite Suite Pro.fxplug
mposite Suite Pro User Guide
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 ACTIVATING, DEACTIVATING AND 
TRANSFERRING LICENSES

Activation Options

Internet Activate (Recommended)
Activates Composite Suite Pro over the Internet.

Request License from Self-Service Website
If you do not have an Internet Connection on the computer where you want to 

run Composite Suite Pro, use this option. The self-service website will generate 

a license file which you can then transfer to the desired computer.

Telephone Activation
Allows you to activate Composite Suite Pro when you do not have access to 

the Internet at all.

Install a License File
Loads a license file obtained from the self-service website or received by email.

Note: If you experience an error when using Internet Activate, it is because you or your 
company uses a proxy server to access the Internet and/or your firewall is blocking our 
program’s access to the Internet. For proxy server users, select Advanced Options and 
enter the appropriate proxy server settings. For firewall users, open your firewall 
software and allow our software to access the Internet.

Deactivation Options
Once Composite Suite Pro has been activated, you can access the 

Deactivation Options by selecting the License menu.

Internet Deactivate (Recommended)
Deactivates Composite Suite Pro over the Internet and is only available if you 

initially activated over the Internet. Use this method to return your Product Code 

back to the activation server. You will then be able to use your Product Code to 

activate Composite Suite Pro on another computer.
Composite Suite Pro User Guide    
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Remove License
Permanently removes the Composite Suite Pro license from your computer. 

You will no longer be able to activate Composite Suite Pro using the Product 

Code or license file that you originally activated with. Only use this option if 

instructed by customer support.

Note: Do not use Remove License to move the license to another computer.

To deactivate Composite Suite Pro:

1 Open the License menu.

• After Effects: Apply a Composite Suite Pro filter and click on Options in the Effect 
Controls window.

• Apple Final Cut Pro: Apply a Composite Suite Pro filter and click on License at the 
bottom of the Filters tab.

• Avid Editing Systems: Apply a Composite Suite Pro filter and click on the icon at 
the top left of the Effect Editor.

2 Choose Internet Deactivate (Recommended) and click Next.

License Transfer
Your Product Code allows you to run Composite Suite Pro on one computer at 

a time. However, you may transfer the license by deactivating on one computer 

and activating on another.

Internet Deactivate / Internet Activate is the preferred method of license 

transfer between computers, but is only available if you initially activated over 

the Internet and currently have Internet access. If you do not have Internet 

access, you will need to contact customer support to assist you in transferring 

the license.

To transfer a license:

1 Open the License menu.

• After Effects: Apply a Composite Suite Pro filter and click on Options in the Effect 
Controls window.

• Apple Final Cut Pro: Apply a Composite Suite Pro filter and click on License at the 
bottom of the Filters tab.

• Avid Editing Systems: Apply a Composite Suite Pro filter and click on the icon at 
the top left of the Effect Editor.
mposite Suite Pro User Guide
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2 Choose Internet Deactivate (Recommended) and click Next.

Composite Suite Pro is now deactivated.

3 On the target computer, select Activate Composite Suite Pro and follow the 
instructions.

Composite Suite Pro will then activate on the new computer.
Composite Suite Pro User Guide    
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 COMPOSITING ISSUES

With Composite Suite Pro plug-ins that take over compositing in Adobe After 

Effects and Apple Final Cut Pro, there are certain situations to be aware of.

Adobe After Effects
1 Color Paste, Composite, Drop Shadow, Edge Composite, Holdout Composite, 

Light Wrap, Math Composite, Non-Additive Mix and Optical dissolve crop or pad 
the background input to the foreground resolution. The work around is:

• Solution: Precompose the layer that will be used as the foreground into a composition 
whose image size matches that of the layer to be used as the background or vise-versa.

2 Placing a Holdout Composite, Math Composite or Non-Additive Mix plug-in at the 
top of a composition will cover up anything going on below it. The work arounds 
are:

• Solution #1: Position the Holdout Composite, Math Composite or Non-Additive Mix plug-
in and its associated layers at the bottom of the layer stack.

• Solution #2: Precompose the layers being covered up into their own composition and 
use this new composition as the Background input to the Holdout Composite, Math 
Composite or Non-Additive Mix plug-in.

3 If you have other plug-ins or filters applied to a layer that you want to use in one 
of the input selectors, they will not be recognized. The work around is:

• Solution: Precompose the layer and its associated plug-ins or filters into its own 
composition. The precomposed layer can then be used in one of the Composite Suite 
Pro input selectors.

4 After Effects Masking is disabled when using the Matte input of the Composite 
plug-in. The work arounds are:

• Solution #1: Place a copy of the background clip above the Composite plug-in and its 
associated layers. Mask out the unwanted portion on this copied layer and it will get rid 
of any unwanted foreground areas.

• Solution #2: Crop the foreground clip from within the Composite plug-in.
mposite Suite Pro User Guide
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Apple Final Cut Pro
1 Plug-ins that contain Background or Matte selectors such as Composite, 

Holdout Composite, Math Composite and Non-Additive Mix require that the 
image placed in the Background or Matte selector be the same resolution as the 
image it is being applied to. Otherwise, the input image will be automatically 
scaled to a different resolution yielding unexpected results. The work around is:

• Solution: Make sure that the image placed in the Background or Matte selector is the 
same resolution as the image it is being applied to.
Composite Suite Pro User Guide    
• 
• 
•
•
•



   Co

12 Introduction

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 INTRODUCTION

Composite Suite Pro features a well rounded collection of visual effects plug-

ins that were previously only available in-house at a Hollywood based feature 

film effects facility. Tested in the rigors of everyday production, Composite Suite 

Pro provides all that is needed to combine multiple images by utilizing 

compositing tricks and techniques, color correction, blur, grain, matte 

manipulation, lens distortion, lighting effects and edge blending. Eradicate the 

most common effects problems or employ specialized compositing tools for 

combining imagery such as fire, smoke and explosions. Cutout or isolate 

objects using a proprietary matte generator or pick from a variety of color 

correctors and natural lighting effects to spice up your images.

Composite Suite Pro includes the following plug-ins: Blur, Blur Depth, Camera 

Flash, Color Correct, Colorize, Colorize Gradient, Color Paste, Composite, 

DeArtifact, DeFocus, DeFog, Distortion, Drop Shadow, DVE, Edge Composite, 

Film Masks, Frame Averager, F-Stop, Gobo, Grain, Glow Edges, Glow Effects, 

HDTV Masks, Holdout Composite, Light, Light Wrap, Math Composite, Matte 

Generator, Matte Repair, Non-Additive Mix, Optical Dissolve, Ozone, Printer 

Points, Selective Color Correct, Temperature and Title Blur.
mposite Suite Pro User Guide



• 

Tutorials  13 

• 
• 
• 
•
•
•

 TUTORIALS

Blur
1 Apply Blur.

2 Adjust the Horizontal Blur slider.

Since the Gang button is activated, the Vertical Blur amount will match the 

Horizontal value.

3 Un-click the Gang slider and now the Horizontal and Vertical sliders can be 
moved independently.

4 In After Effects and Final Cut Pro, set the Position of the blur if you’d like. 

By default, the Position is set to Centered, where the image is equally blurred 

inward and outward. You can also set the Position to Inner or Outer. Inner and 

Outer are good for shrinking or growing mattes.

5 Change the Quality setting from Box to Gaussian.

Gaussian is a higher quality blur, but comes with a price--it’s slower.

Go to the Blur plug-in for more information.
Composite Suite Pro User Guide    
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Blur Depth
1 Apply Blur Depth.

By default, a generated matte is used to create the selective blur effect.

Note to Avid Users: Blur Depth is a two track effect and must be applied to the upper 
track. The upper track is used as the depth source when Depth is set to Input. If you 
want to use the same image as the depth source, just place the same image on two 
adjacent tracks.

2 Adjust the Horizontal and Vertical Blur to your liking.

3 Change your View to Depth to see the matte values. 

The areas that are white in the matte are the areas where blur will be 

introduced. The location of the blur within the scene can be adjusted by 

modifying the Matte > Position and Matte > Range parameters.

4 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

5 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

6 Increase the Matte > Blur parameter to soften the transition areas of the matte.

7 Change your View to Output to see the filtered image.

The Blur Depth plug-in can also use a grad or an image as the depth source 

instead of the matte.

8 Set the Depth to Grad.

9 Adjust the Grad > Direction, Corner Points and Size to change where the blur is 
added.

Go to the Grad section of General Controls to see how the Grad controls work.

10 To use an image as the depth source:

Adobe After Effects

• Change Depth > Depth to Input. 

• Select the layer you want to use from the Depth > Input selector.

Apple Final Cut Pro

• Change Depth > Depth to Input. 

• Drag and drop a clip onto the clip icon to the right of the Depth > Input parameter.

Avid Editing Systems

• Change Depth > Depth to Input. 
mposite Suite Pro User Guide
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• The track that you added Depth of Field to is now used as the depth source and 
applied to the track below. 

Go to the Blur Depth plug-in for more information.

Camera Flash
1 Apply Camera Flash.

2 Adjust both the Amount and Intensity to set the brightness of the Camera Flash.

3 Set the Blur to change the softness of the light.

Go to the Camera Flash plug-in for more information.
Composite Suite Pro User Guide    
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Color Correctors
1 Apply Color Correct, F-Stop, Printer Points, Telecine or Temperature.

2 Adjust any of the controls in the Master group.

The master settings affect the entire image. However, you can also adjust the 

color selectively in the shadow, midtone and highlight regions.

Note: Lift, Gamma and Gain in the Telecine filter are the same as Shadows, Midtones 
and Highlights.

3 Change your View to Shadows, Midtones or Highlights to see the values used for 
these regions.

The areas that are white will be affected by the Shadows, Midtones or 

Highlights color controls. The regions defined as shadows, midtones or 

highlights can be adjusted by modifying the Position and Range parameters.

4 Use the Shadows, Midtones or Highlights > Position parameters if you want to 
select different values.

5 Increase the Shadows, Midtones or Highlights > Range controls to add more 
values to the adjustment. Decrease for less values.

6 Change your View to Output to see the image.

7 Adjust the color controls in the Shadows, Midtone or Highlight controls to see 
how it affects your image.

Go to the Color Corrector plug-ins for more information.
mposite Suite Pro User Guide
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Colorize
1 Apply Colorize.

2 Choose your color by clicking on the Color > Color box and select a color.

3 Try out the different colorization methods in the Color > Color Mode pop-up 
menu.

4 If you want less colorization of the image, turn down the Color > Opacity.

You can also use a gradient in combination with colorization.

5 To use a gradient with Colorize, click on Grad > Enable.

6 Adjust the Grad > Direction, Corner Points and Size.

Go to the Grad section of General Controls to see how the Grad controls work.

7 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

Go to the Colorize plug-in for more information.
Composite Suite Pro User Guide    
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Colorize Gradient
1 Apply Colorize Gradient.

2 Choose your color by clicking on the Shadows, Midtones or Highlights > Color 
boxes and selecting a color.

3 Adjusting the Shadows, Midtones or Highlights > Position slider will set where 
the colors are applied to the image.

4 If you want less coloring of the image, turn down Opacity.

You can also use a gradient to control where the colorization is applied.

5 To use a gradient, click on Grad > Enable.

6 Adjust the Grad > Direction, Corner Points and Size.

Go to the Grad section of General Controls to see how the Grad controls work.

7 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

Go to the Colorize Gradient plug-in for more information.

Color Paste
1 Stack your foreground image, what you want to color paste, above a background 

track/layer.

2 Apply the Color Paste plug-in to the foreground track/layer.

3 Adjust the Opacity and Color to achieve the desired effect.

Go to the Color Paste plug-in for more information.
mposite Suite Pro User Guide
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Composite
1 Apply Composite:

Adobe After Effects

• To use the Composite plug-in with Adobe After Effects, you can work with either 
two or three layers. When working with three layers, the layers should be stacked 
in the following order from bottom to top: matte, background and foreground. 
When working with two layers, the top layer must be a RGB+Alpha image.

• For a three layer effect, apply the Composite plug-in to the foreground layer. For 
a two layer effect, apply the Composite plug-in to the layer that contains the 
RGB+Alpha image.

• When using three layers, select the layer containing the Matte using the Matte 
selector. You should be aware that the Matte Input expects an Alpha channel by 
default. If you want to use a channel other than the Alpha to create your 
composite, go to Matte > Use and select a different channel.

Apple Final Cut Pro

• To use the Composite plug-in with Apple Final Cut Pro, you work with two video 
tracks. The tracks should be stacked in the following order from bottom to top: 
background and then foreground. 

• The Alpha channel used to create the Composite can be from either the 
foreground’s Alpha channel or from a separate image. If you don’t want to use the 
foreground’s Alpha channel or if it does not have one, drag the image to be used 
as the Alpha channel from the Browser and drop it onto the clip icon to right of the 
Matte parameter.

Avid Editing Systems

• To use the Composite plug-in with Avid Editing Systems, you can work with either 
two or three video tracks. When working with three tracks, the video tracks should 
be stacked in the following order from bottom to top: background, foreground and 
matte. When working with two tracks, the top track must contain a Matte Key 
(RGB+Alpha image).

• For a two track effect, apply the Composite plug-in to the track that contains the 
Matte Key. For a three track effect, apply the Composite plug-in to the track that 
has the matte.

• Depending on what is black and white in your matte, you may need to go to the 
Matte group and toggle Invert to off. By default, Composite inverts the matte to be 
compatible with the way Avid treats matte values in a Matte Key.

2 If you want, Color Correct, Blur or Grain the Foreground image.
Composite Suite Pro User Guide    
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3 The Foreground can be transformed using the DVE parameters.

Note: There are two sets of on-screen DVE controls in Composite. The point controls 
that are offset to the right and down are for the drop shadow, while the point controls 
located on the corners and center of the image are for the foreground. To see the on-
screen controls in After Effects, you must highlight the “Composite” effect title in the 
Effect Controls window. On Avid Editing Systems, you may need to zoom out to see the 
on-screen controls.

4 Use the DVE > Crop to get rid of unwanted areas of the Foreground.

5 In the Matte group, apply Shrink/Grow, Blur and Clip controls to the matte if 
needed.

6 Add a Drop Shadow to the Foreground using the Color, Opacity, Blur and DVE 
controls in the Drop Shadow Group.

7 Use the Edge parameters to clean up ratty edges, if any, in the composite.

Go to the Composite plug-in for more information.

DeArtifact
1 Apply DeArtifact.

Note: The DeArtifact parameters default to settings that are good for DV footage. If you 
are working at higher HD resolutions, you will want to increase the Horizontal and 
Vertical Blur settings.

2 Adjust the Horizontal Blur to remove any artifacting.

It is usually best to blur mostly on the horizontal axis.

3 Adjust the Vertical Blur if needed.

Go to the DeArtifact plug-in for more information.
mposite Suite Pro User Guide
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DeFocus
1 Apply DeFocus.

2 Adjust the Blur to your liking.

3 Set the Aperture > Curvature to 0 if you prefer the out-of-focus points of light be 
polygonal in shape.

In some of the plug-ins, a matte is generated to create the desired effect--in this 

case, Bokeh effects. Bokeh is the Japanese term that describes the quality of 

out-of-focus points of light. In defocused areas, each point of light becomes a 

shape--either a circle or a polygon. The shape grows in size as the amount of 

defocusing is increased.

4 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where Bokeh effects will be 

introduced. The location of the Bokeh effects within the scene can be adjusted 

by modifying the Matte > Position and Matte > Range parameters.

5 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

6 Change you View to Aperture to see the generated Bokeh effects.

7 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

The Matte > Range parameter has been purposely set to a low value. A high 

range setting will slow down the plug-in significantly.

8 In addition to Matte > Range, you can also raise the Aperture > Threshold value 
to limit the amount of out-of-focus points of light.

9 Change your View to Output to see the filtered image.

See the DeFocus plug-in for more information.
Composite Suite Pro User Guide    
• 
• 
•
•
•



   Co

22 Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

DeFog
1 Apply DeFog.

2 Click on the DeFog > Color picker and click on an area of fog.

This sets the color of the fog to be removed.

3 Adjust the DeFog > DeFog parameter to remove more fog or mist.

The fog is removed in a radial pattern emanating from the vanishing point. For 

instance, if your fog moves in the direction of top right to bottom left, set your 

vanishing point towards the top right corner and the fog removal will be more 

intense at the upper right and fall off at the bottom left. However, in most cases, 

the vanishing point can be left in the center of the screen and you will obtain 

acceptable results.

4 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the screen.

Note: To see the on-screen controls in After Effects, you must highlight the “DeFog” 
effect title in the Effect Controls window.

If the defogging operation causes the shadow areas to become too contrasty, 

adjust the Min Depth slider to a lower value. This will bring back some shadow 

detail.

5 Lower the Min Depth value if you have lost to much detail in the shadow portions 
of the image.

See the DeFog plug-in for more information.
mposite Suite Pro User Guide
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Distortion
Distortion corrects for pin-cushioning and barrel distortion of camera lenses. It 

is also useful for creating the look of a wide angle lens.

1 Apply Distortion.

2 Start by adjusting the Distortion control to straighten out any curved lines that 
should be straight.

Note: Positive Distortion values correct pin-cushioning while negative values correct 
barrel distortion.

Depending on the lens that was used, you may need to also adjust the 

Anamorphic Squeeze and Curvature X and Y parameters.

See the Distortion plug-in for more information.
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Drop Shadow
1 Apply Drop Shadow:

Adobe After Effects

• To use the Drop Shadow plug-in with Adobe After Effects, the layers should be 
stacked in the following order from bottom to top: background and then a 
foreground that is a RGB+Alpha image.

• Apply the Drop Shadow plug-in to the top foreground layer.

Apple Final Cut Pro

• To use the Drop Shadow plug-in with Apple Final Cut Pro, the video tracks should 
be stacked in the following order from bottom to top: background and then a 
foreground that is a RGB+Alpha image.

• Apply the Drop Shadow plug-in to the top foreground track.

Avid Editing Systems

• To use the Drop Shadow plug-in with Avid Editing Systems, you can work with 
either two or three video tracks. When working with three tracks, the video tracks 
should be stacked in the following order from bottom to top: background, 
foreground and matte. When working with two tracks, the top track must contain 
a Matte Key (RGB+Alpha image).

• For a two track effect, apply the Drop Shadow plug-in to the track that contains 
the Matte Key. For a three track effect, apply the Drop Shadow plug-in to the track 
that has the matte.

• Depending on what is black and white in your matte, you may need to toggle Invert 
Matte to off. By default, Drop Shadow inverts the matte to be compatible with the 
way Avid treats matte values in a Matte Key.

2 Use the DVE controls to Position, Scale, Rotate or Corner-Pin the drop shadow.

3 Set the Color, Opacity and Blur.

Go to the Drop Shadow plug-in for more information.
mposite Suite Pro User Guide
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DVE
1 Apply DVE.

2 Using the On-Screen controls for Position and Corner-Pin:

• Adobe After Effects: To see and adjust the Position or Corner-Pin on-screen 
controls, make sure that the effect title in the Effect Controls window is 
highlighted. 

• Apple Final Cut Pro and Autodesk Combustion: You must activate the cross hair 
icon next to the Position or Corner-Pin parameters to see and adjust the on-screen 
controls.

• Avid Editing Systems: Drag any of the on-screen controls and the image will be 
adjusted. You may need to zoom the image out a bit to see the Corner-Pin on-
screen controls.

3 Use the DVE controls to Crop, Position, Scale, Rotate, Shear or Corner-Pin the 
image.

Go to the DVE plug-in for more information.
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Edge Composite
1 Apply Edge Composite:

Adobe After Effects

• To use the Edge Composite plug-in in Adobe After Effects, the layers should be 
stacked in the following order from bottom to top: background and then a 
foreground that is a RGB+Alpha image.

• Apply the Edge Composite plug-in to the top foreground layer.

Apple Final Cut Pro

• To use the Edge Composite plug-in in Apple Final Cut Pro, the video tracks 
should be stacked in the following order from bottom to top: background and then 
a foreground that is a RGB+Alpha image.

• Apply the Edge Composite plug-in to the top foreground track.

Avid Editing Systems

• To use the Edge Composite plug-in in Avid Editing Systems, you can work with 
either two or three video tracks. When working with three tracks, the video tracks 
should be stacked in the following order from bottom to top: background, 
foreground and matte. When working with two tracks, the top track must contain 
a Matte Key (RGB+Alpha image).

• For a two track effect, apply the Edge Composite plug-in to the track that contains 
the Matte Key. For a three track effect, apply the Edge Composite plug-in to the 
track that has the Matte.

• Depending on what is black and white in your matte, you may need to toggle Invert 
Matte to off. By default, Edge Composite inverts the matte to be compatible with 
the way Avid treats matte values in a Matte Key.

2 Change the View to Edge Matte. 

3 Using the Size control, set the thickness of the Edge Matte.

4 Switch the View back to Output.

5 Adjust the Color Correction, Blur and Opacity of the edge.

Go to the Edge Composite plug-in for more information.
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Film Masks
Film Masks is only available for Adobe After Effects and After Effects 

compatible programs.

1 Apply Film Masks.

2 From the Image pop-up menu, select the option that matches your image size. 
Use Variable for image sizes other than 2048x1556 and 1828x1332.

3 Expand the Aperture group and choose Full (Full Aperture) or Academy Offset.

4 If you are using the Full setting, set the Common pop-up menu to Center or Top.

5 Open the Aspect Ratio group and select the from the available options. 

6 Expand the Masks/Reticle group and adjust the Opacities and Color to your 
liking.

Go to the Film Masks plug-in for more information.

Frame Averager
1 Apply Frame Averager.

2 Set the Frames parameter to the amount of frames that you want to blend.

Go to the Frame Averager plug-in for more information.
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Glow Edges
1 Apply Glow Edges.

2 Select either the Add or Screen Blend Mode. 

Add will burn out highlights while the Screen blend mode will retain them.

3 Adjust the Glow > Brightness, Blur and Color settings to your liking.

In Glow Edges, an edge matte is generated to create the desired effect.

4 Change your View to Edge to see the matte values. 

The areas that are white in the edge matte are the areas where glow will be 

introduced.

5 Adjust the Edge > Brightness to make sure that you have sufficient white areas 
in the edge matte.

6 Set the Edge > Blur to smooth out the edge matte.

7 Change your View to Output to see the filtered image.

See the Glow Edges plug-in for more information.
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Glow Effects
1 Apply Glow Effects.

2 Use either an Add, Screen or Normal Blend mode.

Add will burn out highlights while the Screen blend mode will retain them. 

Normal, on the other hand, mixes diffusion with the original image.

3 Adjust the Amount, Blur and Color settings to your liking.

Note: Glow > Color has no effect when using the Normal blend mode.

In some of the plug-ins, a matte is generated to create the desired effect--in this 

case, diffusion and glows.

4 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where diffusion/glow will be 

introduced. The location of the diffusion/glow within the scene can be adjusted 

by modifying the Matte > Position and Matte > Range parameters.

Note: Matte > Position and Range have no effect when using the Normal blend mode.

5 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

6 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

7 Increase the Matte > Blur parameter to soften the transition areas of the matte.

Change your View to Output to see the filtered image.

Go to the Glow Effects plug-in for more information.
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Grain
1 Apply Grain.

2 Adjust the Red, Green and Blue Size parameters.

The Size parameters control the size of the grain. Sometimes a film stock’s 

grain structure varies in size from one color channel to another, so individual 

control has been given. The larger the Size settings, the larger the grain will be.

3 Manipulate the Red, Green and Blue Amount parameters.

The Amount parameters set the red, green and blue intensities of the grain. 

Film stocks generally have varying amounts of red, green and blue intensities 

with the blue intensity generally higher than the rest. If you turn the red, green 

and blue amount sliders to a value of 0, the grain will disappear.

4 Change the Red, Green and Blue Softness parameters.

The Softness parameters set the red, green and blue softness of the grain. 

Some film stock’s grain structure varies in softness from one color channel to 

another, so individual control has been given. Normally, only minor softness 

adjustments are necessary, usually between a value of 0-1.

5 Adjust the Response Position and Response Range to control where you will see 
grain in the image. 

In most cases, film grain is apparent over the entire image except the brightest 

whites with the black areas being the most affected. A low Response Position 

value places grain in the darkest image values, while a high Response Position 

value places grain in the brightest areas. Response Range will increase or 

decrease the area where grain is added to the image based on the value of the 

slider.

6 If you want, use Response Minimum to set the minimum level of grain that is 
always added to the image.

7 You can also select one of the grain presets from the pop-up list.

Note: On Avid Editing Systems the Grain parameters are deactivated when a preset 
has been selected.

Go to the Grain plug-in for more information.
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HDTV Masks
HDTV Masks are only available for Adobe After Effects, After Effects 

compatible programs and Apple Final Cut Pro.

1 Apply HDTV Masks to a 1920x1020 track/layer.

Note: HDTV Masks can only be used on 1920x1080 HDTV sized images.

2 Open the Aspect Ratio group and select the from the available options. 

3 Expand the Masks/Reticle group and adjust the Opacities and Color to your 
liking.

Go to the HDTV Masks plug-in for more information.
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Holdout Composite
1 Apply Holdout Composite:

Adobe After Effects

• To use the Holdout Composite plug-in in Adobe After Effects, the layers should 
be stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Holdout Composite plug-in to the top foreground layer.

• Using the Background pop-up menu, choose the layer to be used as the 
background.

Apple Final Cut Pro

• To use the Holdout Composite plug-in in Apple Final Cut Pro, apply it to your 
foreground track.

• Drag the image to be used as the background from the Browser and drop it onto 
the clip icon to right of the Background parameter. The selected image must be 
the same resolution as the foreground.

Avid Editing Systems

• To use the Holdout Composite plug-in in Avid Editing Systems, the video tracks 
should be stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Holdout Composite plug-in to the top foreground track.

Holdout Composite creates a luminance matte of the foreground and pastes it 

as black (or optionally as another color) over the background. You can adjust 

Black and White Clip of this luminance matte using the Matte controls.

2 Change the View to Matte.

3 If needed, adjust the Matte > Black Clip to make blacks in the matte blacker.

4 If needed, adjust the Matte > White Clip to make whites in the matte whiter.

5 Change the View back to Output.

6 Choose either the Add, Screen or Lighten Blend mode. Add or Screen usually 
work best.

7 Set the Level control to your liking.

If the blacks in your composite look milky, it is usually because the foreground 

blacks are not entirely black. These impure black areas will be added to the 

background image as part of the Holdout Composite causing the final result to 

have milky blacks. You can improve milky blacks using Black Clip.
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8 Use Black Clip if the composite’s blacks look milky.

Go to the Holdout Composite plug-in for more information.
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Light / Gobo
1 Apply Light or Gobo:

Adobe After Effects and Apple Final Cut Pro

• Apply the Light or Gobo plug-in to a layer/track.

Avid Editing Systems

• Light and Gobo require two video tracks.

• Place the same image on two adjacent video tracks.

• Apply the Light or Gobo plug-in to the upper track of the two adjacent tracks.

2 To select a different gobo, make a choice in the Gobo > Category pop-up menu 
and then pick the desired gobo within the selected group.

3 Choose Light > Blend > Add, Screen or Subtract for the blend mode.

Add will burn out highlights while Screen will retain them. Subtract, on the other 

hand, will add shadow in place of light in the area of the gobo.

4 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

5 Using the Gobo > DVE controls, you can transform the gobo.

6 To apply a custom light color to the image, click on the Light > Color box and 
select a color.

Note: The Color picker allows you to treat the light with a custom color, but is only 
active when the Custom option has been selected in the Light > Gels pop-up menu.

7 To apply a colored gel to the light, select one from the Light > Gels pop-up menu.

8 Combine the gobo with a matte by changing the Gobo > Blend Mode from Gobo 
Only to Multiply.

I like the Multiply blend mode because it only adds the gobo in the areas of the 

matte.

9 Change your View selector to Matte to see the matte values.

The default matte settings are preset to a highlight matte to create the light 

effect. If you are not seeing sufficient light, your matte should be adjusted. The 

areas that are white in the matte are the areas where light will be added into the 

image. The location of the light within the scene can be adjusted by changing 

the Matte > Position and Range parameters.

10 Change the Matte > Position parameter if you want to select different values to 
be used for the light.
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11 Increase the Matte > Range value to add more light into the scene. Decrease for 
less light.

12 Increase the Matte > Blur parameter to soften the transition areas of the light.

13 Change the View selector from Matte to Output.

14 The softness of the light can also be adjusted using the Light > Blur setting.

15 To use an image as the light source:

Adobe After Effects

• Select Input from the Gobo > Category menu. 

• Select a layer from the Gobo > Input menu. 

Apple Final Cut Pro

• Select Input from the Gobo > Category menu.

• Drag and drop a clip onto the clip icon to the right of the Gobo > Input parameter.

Avid Editing Systems

• Place the image to be used as a light source on a track above the image you want 
to add the light to.

• Apply the Light or Gobo plug-in to the image to that you would like to use as a light 
source.

• Select Input from the top most pop-up in the Gobo group. 

• The track that you added the Light or Gobo plug-in to is now used as the light 
source and applied to the track below it.

Note: If the camera is moving and you want to add a gobo, the gobo won’t 
automatically follow the camera. You will either need to manually move the gobo to 
follow the camera or better, use Motion Tracking software to Match Move the gobo to 
the camera move. Track the motion of your source image, set your View to Gobo, apply 
the tracker motion to your gobo and render it. To use the newly tracked and rendered 
gobo as a light source, follow the previous instructions listed for using an image as the 
light source.

Go to the Light plug-in for more information.
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Light Wrap
1 Apply Light Wrap:

Adobe After Effects

• To use the Light Wrap plug-in with Adobe After Effects, the layers should be 
stacked in the following order from bottom to top: background and then a 
foreground that is a RGB+Alpha image.

• Apply the Light Wrap plug-in to the top foreground layer.

• Using the Background pop-up menu, choose the layer to used for the Light Wrap 
source.

Apple Final Cut Pro

• To use the Light Wrap plug-in with Apple Final Cut Pro, the video tracks should 
be stacked in the following order from bottom to top: background and then a 
foreground that is a RGB+Alpha image.

• Apply the Light Wrap plug-in to the top foreground track.

• Drag the image to be used as the Light Wrap source from the Browser and drop it 
onto the clip icon to right of the Background parameter.

Avid Editing Systems

• To use the Light Wrap plug-in with Avid Editing Systems, you can work with either 
two or three video tracks. When working with three tracks, the video tracks should 
be stacked in the following order from bottom to top: background, foreground and 
matte. When working with two tracks, the top track must contain a Matte Key 
(RGB+Alpha image).

• For a two track effect, apply the Light Wrap plug-in to the track that contains the 
Matte Key. For a three track effect, apply the Light Wrap plug-in to the track that 
has the matte.

• Depending on what is black and white in your matte, you may need to toggle Invert 
Matte to off. By default, Light Wrap inverts the matte to be compatible with the way 
Avid treats matte values in a Matte Key.

2 Change the View to Light Wrap. 

3 Using the Wrap control, set the thickness of the Light Wrap Matte.

4 Switch the View back to Output.

5 Adjust the Light setting to the appropriate brightness.

Go to the Light Wrap plug-in for more information.
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Math Composite
1 Apply Math Composite:

Adobe After Effects

• To use the Math Composite plug-in with Adobe After Effects, the layers should be 
stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Math Composite plug-in to the top foreground layer.

• Using the Background pop-up menu, choose the layer to used as the background.

Apple Final Cut Pro

• To use the Math Composite plug-in with Apple Final Cut Pro, the video tracks 
should be stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Math Composite plug-in to the top foreground track.

• Drag the image to be used as the background from the Browser and drop it onto 
the clip icon to right of the Background parameter.

Avid Editing Systems

• To use the Math Composite plug-in with Avid Editing Systems, the video tracks 
should be stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Math Composite plug-in to the top foreground track.

2 Choose the appropriate mode from the Blend pop-up menu.

If the blacks in your composite look milky, it is usually because the foreground 

blacks are not entirely black. Depending on the Blend mode that you choose, 

the impure black areas may be added to the background image causing the 

final result to have milky blacks. You can improve milky blacks using Black Clip.

3 Use Black Clip if the composite’s blacks look milky.

4 Set the Level control to your liking.

Go to the Math Composite plug-in for more information.
Composite Suite Pro User Guide    
• 
• 
•
•
•



   Co

38 Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Matte Generator
1 Apply the Matte Generator:

• To use the Matte Generator, the layers/tracks should be stacked in the following 
order from bottom to top: background and then foreground.

• Apply the Matte Generator filter to the foreground layer/track.

• The foreground items that you extract with the Matte Generator will automatically 
be composited over the background.

Note: The layer/track below the one that you applied the Matte Generator to is 
automatically used as the background.

2 Change your View to Matte 1 to see the matte values.

Whatever is white in the matte will be considered as foreground areas to be 

extracted and whatever is black will show through to the background.

3 Change the Matte 1 > Extract On parameter to create a matte based on a whatever 
image values you choose.

Extract On determines the image values that will be used to generate the matte.

4 Change the Matte 1 > Position parameter if you want to select different values to 
be used for the matte.

The Position control selects the image values to be used in the matte based on 

the Extract On setting. If the selection is created using Luminance, a high 

Position value shows the brightest image values as white values in the matte. 

A low Position value shows the darkest image values as white values in the 

matte.

5 Increase the Matte 1 > Range control to add more values to the matte. Decrease 
for less values.

Range increases or decreases the range of values in the matte. A low Range 

value indicates a narrow range of values. A high Range value indicates a large 

range of values included in the matte.

6 Adjust the Matte 1 > Black Clip and White Clip if you want to make the blacks 
blacker and the whites whiter.

7 If the edges of your matte need smoothing, use the Matte 1 > Shrink/Grow, Blur 
or Wrap parameters to take care of them.
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Up to five mattes can be extracted and combined. After extracting the first 

matte, you can extract new mattes with the controls in Matte sections 2-5 and 

choose the Blend mode by which they will be combined.

Note: You must first choose a Blend mode in Matte’s 2-5 before they can be displayed 
in the View menu or contribute to the final matte.

8 Change the View to Output to see the composite created with the generated 
matte.

Go to the Matte Generator plug-in for more information.
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Matte Repair
1 Apply Matte Repair.

2 Change your View to Matte to see the matte values.

3 Set the Use pop-up menu for the image channel you want to repair.

Note: The Use parameter is not available in Avid Editing Systems. When applied to a 
Matte Key, the Alpha Channel is used, otherwise it uses the luminance of the RGB 
channels.

4 Adjust Black Clip if you want to make the blacks blacker.

5 Adjust White Clip if you want to make the whites whiter.

6 If the edges of your matte need smoothing, use the Shrink/Grow or Blur 
parameters to take care of them.

If you applied Matte Repair to a RGB+Alpha image and there is a background 

layer/track below it, you can make adjustments and see the effect it has on your 

composite when the View is set to Output.

7 Change the View back to Output.

Go to the Matte Repair plug-in for more information.
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Non-Additive Mix
1 Apply Non-Additive Mix:

Adobe After Effects

• To use the Non-Additive Mix plug-in with Adobe After Effects, the layers should be 
stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Non-Additive Mix plug-in to the top foreground layer.

• Using the Background pop-up menu, choose the layer to used as the background.

Apple Final Cut Pro

• To use the Non-Additive Mix plug-in with Apple Final Cut Pro, apply it to a track.

• Drag the image to be used as the background from the Browser and drop it onto 
the clip icon to the right of the Background parameter.

Avid Editing Systems

• To use the Non-Additive Mix plug-in with Avid Editing Systems, the video tracks 
should be stacked in the following order from bottom to top: background and then 
foreground.

• Apply the Non-Additive Mix plug-in to the top foreground track.

2 Set the Mix value so that the foreground image is blended with the background.

If the blacks in your composite look milky, it is usually because the foreground 

blacks are not entirely black. These impure black areas will be added to the 

background image as part of the Non-Additive Mix causing the final result to 

have milky blacks. You can improve milky blacks using Black Clip.

3 Use Black Clip if the composite’s blacks look milky.

Go to the Non-Additive Mix plug-in for more information.
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Optical Dissolve
1 Apply Optical Dissolve:

• The layers/tracks should be stacked in the following order from bottom to top: 
background and then foreground.

• Apply the Optical Dissolve plug-in to the top foreground layer/track.

2 Set the Opacity value so that the foreground image is blended with the 
background.

Go to the Optical Dissolve plug-in for more information.
mposite Suite Pro User Guide



• 

Tutorials  43 

• 
• 
• 
•
•
•

Ozone
1 Apply Ozone.

2 Use the View menu to look at Zones 0-10.

The selected zone is represented as a black and white image. The values 

shown as white in the selected zone are the portions of the image that will be 

modified when using the color adjustments. As the values drop-off to black, so 

does the strength of whatever adjustments you’ll make. Although the zone’s 

Position and Range parameters are preset according to the Digital Zone 

system, they can be changed if you want.

3 If you’d like, change the Position and Range parameters for the selected zone.

The Position value pinpoints the color values to be used in the selected zone. 

For instance, if the zones are created using Luminance, a high Position value 

shows the brightest image values as white values in the zone. A low Position 

value shows the darkest image values as white values in the zone. The Range 

value increases or decreases the range of values in the selected zone.

4 Make sure that the View is set to Output.

The Viewer now shows the full color image.

5 To modify your image, adjust any combination of the Hue, Saturation, 
Brightness, Contrast, Gamma, Red, Green, Blue and Temperature sliders for 
each zone.

Your adjustments occur on a zone by zone basis, but you view the result of all 

color corrections simultaneously.

Go to the Ozone plug-in for more information.
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Selective Color Correct
1 Apply Selective Color Correct.

2 Change your View to Matte to see the matte values. 

In some of the plug-ins, a matte is generated to create the desired effect--in this 

case, selective color correction.

3 Adjust the Matte controls so that the areas that you want to color correct are 
white in the matte.

Go to the Matte section in the Matte Generator plug-in to see how the Matte 

controls work.

4 Change your View to Output to see the image.

5 Adjust the color correct parameters to your liking.

Go to the Selective Color Correct plug-in for more information.
mposite Suite Pro User Guide



• 

Tutorials  45 

• 
• 
• 
•
•
•

Title Blur
Title Blur is only available for Avid Editing Systems.

1 Apply Title Blur:

• To use the Title Blur plug-in with Avid Editing Systems, you can work with either 
two or three video tracks. When working with three tracks, the video tracks should 
be stacked in the following order from bottom to top: background, foreground and 
matte. When working with two tracks, the top track should be an Avid Title or a 
Matte Key (RGB+Alpha image).

• For a two track effect, apply the Title Blur plug-in to the track that contains the 
Avid Title or Matte Key. For a three track effect, apply the Title Blur plug-in to the 
track that has the matte.

• Depending on what is black and white in your matte, you may need to toggle Invert 
Matte to off. By default, Title Blur inverts the matte to be compatible with the way 
Avid treats matte values in an Avid Title or Matte Key.

2 Adjust the Horizontal Blur and the Title is blurred in both the horizontal and 
vertical dimensions since Gang is enabled.

3 Deactivate Gang.

You can now adjust the Horizontal and Vertical Blur independently.

Go to the Title Blur plug-in for more information.
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 GENERAL CONTROLS

There are some general controls that are common to all of the plug-ins. For 

simplicity, they will be listed here.

Grad
Grad is the gradient transition area between the filtered image and the original. 

Its direction, corners and size can be adjusted.

Enable
Turns the Grad on and off.

ND Brightness
Darkens the colored portion of the Grad.

Direction
Controls the direction of the Grad.

Top-to-bottom
The direction of the Grad is from top to bottom.

Bottom-to-top
The direction of the Grad is from bottom to top.

Left-to-right
The direction of the Grad is from left to right.

Right-to-left
The direction of the Grad is from right to left.
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Corner Pin
There are four points around the four corners of the image. By clicking and 

dragging any of the four points, the Grad can be adjusted.

Note: You may need to zoom the image out a bit to see the corner points. In addition, 
to see the corner points in After Effects, make sure that the filter name in the Effect 
Controls window is highlighted. For Final Cut Pro and Combustion, you must activate 
the cross hair icon next to the corner position parameters to see and adjust the corner 
points on the screen.

Upper Left
Controls the X and Y position of the Upper Left Point.

Upper Right
Controls the X and Y position of the Upper Right Point.

Lower Right
Controls the X and Y position of the Lower Right Point.

Photo © THINKSTOCK LLC--www.thinkstock.com
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Lower Left
Controls the X and Y position of the Lower Left Point.

Size
The size of the Grad.

Invert Matte
An Invert Matte parameter has been added to the Avid versions of the 

Composite Suite Pro compositing plug-ins. Avid handles it’s mattes opposite to 

most compositing programs, so the Invert Matte parameter will automatically 

invert the matte to comply with the Avid method.

View 
Chooses what image to view. These choices will vary from plug-in to plug-in.

Output
The view selector displays the output of the plug-in.

Matte
The view selector displays the matte.

Original
The view selector displays the original input clip.
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 BLUR

Description
Can you guess what this one does? That’s right, it blurs the image with 

individual horizontal and vertical controls. It’s fast, high quality and blurs outside 

the frame which removes the dark inward bleeding edges of most blurs. 

Horizontal, vertical or both, Blur uses either Gaussian or Box quality settings.

Go to the Blur Tutorial to see how the plug-in works.

Quality
Selects the quality of the blur.

Box
A fast, lower quality box blur.

Gaussian
A slower, higher quality gaussian blur.
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Position

Centered
The blur is centered, equally blurring inward and outward.

Inner
The image is blurred inward from the edge.

Outer
The image is blurred outward from the edge.

Note: On Avid Editing Systems, Inner and Outer have no effect.

Blur

Horizontal Blur
The image is blurred by a fast, quality blur along the X-axis.

Vertical Blur
The image is blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. When 

ganged, adjust the horizontal slider to affect both values.
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 BLUR DEPTH

Description
Selective blur can be added to a scene by isolating and blurring only a portion 

of the image. The amount of blurring is directly proportionate to the luminance 

of the matte settings, a gradient or an input image.

Go to the Blur Depth Tutorial to see how the plug-in works.

Note to Avid Users: Blur Depth is a two track effect and must be applied to the upper 
track. The upper track is used as the depth source when Depth is set to Input. If you 
want to use the same image as the depth source, just place the same image on two 
adjacent tracks.

Depth
Selects the source for the selective blur effect.

Matte
Use the matte for the depth source.

Before Matte
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Grad
Use a gradient for the depth source.

Strip
Use a strip gradient for the depth source.

Input
Use an image as the depth source. This is useful for 3D programs which render 

out depth mattes.

Input
Load a file to use as the depth source.

To use an image as the depth source in Adobe After Effects:

• Change Depth > Depth to Input. 

• Select the layer you want to use from the Depth > Input selector.

To use an image as the depth source in Apple Final Cut Pro:

• Change Depth > Depth to Input. 

• Drag and drop a clip onto the clip icon to the right of the Depth > Input parameter.

To use an image as the depth source in Avid Editing Systems:

• Blur Depth requires two video tracks.

• Place images on two adjacent video tracks.

• Apply the Blur Depth plug-in to the upper track of the two adjacent tracks.

• Change Depth > Depth to Input. 

• The upper track that you added Blur Depth to is now used as the depth source and 
applied to the track below. 

Blur
Sets how much the image is blurred.
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Grad 
Blur Depth can optionally use a gradient that limits where the filter is applied. 

Grad is the transition area that goes from the blurred portion to the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of General Controls to see how the Grad controls work.

Matte
A matte can be used to create the selective blur effect. Go to the Matte section 

in the Matte Generator plug-in to see how the Matte controls work.
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 CAMERA FLASH

Description
Camera Flash simulates the overexposure that occurs when a film camera is 

stopped.

Go to the Camera Flash Tutorial to see how the plug-in works.

Amount
Controls the transition of the camera flash.

Intensity
Sets the intensity of the overexposure.

Blur
Adjusts the blur of the overexposure.

Before After
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 COLOR CORRECTORS

Description
Composite Suite Pro includes a number of different color correctors that are 

handy for adjusting an image’s color. They include: Color Correct, F-Stop, 

Printer Points, Telecine and Temperature.

Color Correct
Color Correct manipulates red, green and blue values of the overall image and 

separately in user definable shadow, midtone and highlight areas. Hue, 

saturation, brightness, contrast and gamma controls allow for further control.

F-Stop
F-Stop manipulates red, green and blue values of the overall image and 

separately in user definable shadow, midtone and highlight areas using F-Stops 

as the unit of measure. In camera terminology, F-Stops measure the size of the 

lens opening, otherwise known as aperture. Each F-Stop is twice as bright as 

the next. 

Printer Points
Printer Points manipulate the red, green and blue values of the overall image 

and separately in user definable shadow, midtone and highlight areas using 

motion picture laboratory printer points as the unit of measure. When creating 

Before After
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color prints for motion pictures, a contact printer performs scene-to-scene color 

corrections. The most popular printing method is additive printing that uses 

three separate colored sources - red, green, and blue which are combined to 

form the light source that exposes the film. The red, green, and blue light valves 

in the printer are adjusted in values of 1, 2, 3. . . up to 60 for each primary color 

and are called printer points or printer lights. 

Telecine
Telecine emulates the method of color correction done in a telecine film to tape 

transfer suite. Hue, saturation, brightness, contrast, gamma and pedestal 

values of the overall image can be adjusted as well as separately in user 

definable shadow, midtone and highlight areas.

Temperature
Temperature manipulates the temperature, cyan/magenta and brightness 

values of the overall image and separately in user definable shadow, midtone 

and highlight areas.

Go to the Color Corrector Tutorials to see how the plug-ins work.

Master, Shadows, Midtones, Highlights
All of the color correctors can adjust an image by using the controls located in 

the master, shadows, midtones and highlight groups. The Telecine plug-in uses 

the following terminology: Lift (shadows), Gamma (midtones) and Gain 

(highlights). The master settings affect the entire image while adjusting 

parameters within the shadows, midtones and highlights will only affect those 

specific areas.

If you are unsure about what values are included in the shadows, midtones and 

highlights, you can use the View pop-up menu. It will allow you to view the 

shadows, midtones and highlights as a black and white regions. The white 

areas are the areas that will be adjusted by that particular group. For instance, 

if you see white areas while viewing the midtones, then midtone color 
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adjustments will affect only those white areas. If you want to change the default 

areas defined by the shadows, midtones and highlights, you would use the 

Position and Range sliders.

Position
The Position slider pinpoints the values to be considered as shadows, 

midtones, or highlights. A low Position value uses the darkest image values, 

while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 

or highlights. A low Range value indicates a narrow range of values, while a 

high Range value indicates a large range of values.

Go to the Matte section in the Matte Generator plug-in to see how the Position 

and Range controls work.

Color Correct

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Original Shadows Midtones Highlights
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Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Flashing
The Flash parameters mix a color into the image through the use of a standard 

color picker. The default color is white. What in the world is this for? It is a great 

way to add atmosphere to an element. Flash comes from the film term 

“flashing”, which describes the optical process of lowering the contrast of an 

image by flashing it with light.

Flash Amount 
Sets the opacity of the Flash Color. 

Flash Color
The Flash Color can be set through the use of a standard color picker.

F-Stop

Red Exposure
Adds or subtracts red from the image.
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Green Exposure
Adds or subtracts green from the image.

Blue Exposure
Adds or subtracts blue from the image.

Gang
The Red, Green and Blue Exposure slider values can be ganged together. 

Drag the Red Exposure slider to affect all three values.

Note: When Gang is turned on, the Green and Blue sliders don’t physically move. 
However, they will follow the value of the Red slider when Gang is turned on.

Printer Points
The Red, Green and Blue Exposure are set to a value of 25 which represent no 

adjustment. Printer “lights” or points set to 25, 25, 25 are considered to be the 

normal or standard printer setup at most motion picture labs.

Red Exposure
Adds or subtracts red from the image. As in motion picture printing, higher 

values subtract and lower values add.

Green Exposure
Adds or subtracts green from the image. As in motion picture printing, higher 

values subtract and lower values add.

Blue Exposure
Adds or subtracts blue from the image. As in motion picture printing, higher 

values subtract and lower values add.

Gang
The Red, Green and Blue Exposure slider values can be ganged together. 

Drag the Red Exposure slider to affect all three values.

Note: When Gang is turned on, the Green and Blue sliders don’t physically move. 
However, they will follow the value of the Red slider when Gang is turned on.
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Telecine

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Pedestal
Adjusts the black level of the image.

Temperature

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.
mposite Suite Pro User Guide



• 

Color Correctors  61 

• 
• 
• 
•
•
•

Brightness
Adjusts the brightness of the image.
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 COLORIZE

Description
Colorizes the entire image with a selected color using a variety of colorization 

modes.

Go to the Colorize Tutorial to see how the plug-in works.

Colorize

Opacity
Sets the opacity of the color.

Color
Sets the color that the image will be colorized with. Select the desired color 

using the color picker.

Mode
Selects how color is applied to the image.

Before After
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Normal
Colorizes the image while retaining highlights.

Tint
The image is colorized by replacing hue and saturation.

Hue
The image is colorized by only replacing hue.

Lighten
Pixels darker than the color are replaced, and pixels lighter than the color do 

not change.

Darken
Pixels lighter than the color are replaced, and pixels darker than the color do 

not change.

Grad
Colorize can optionally use a gradient that limits where the plug-in is applied. 

Grad is the transition area that goes from the colorized image to the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of General Controls to see how the Grad controls work.
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 COLORIZE GRADIENT

Description
Using multiple colors, Colorize Gradient colorizes the image according to the 

image’s brightness values. 

Go to the Colorize Gradient Tutorial to see how the plug-in works.

Opacity
Sets the overall opacity of the colorization.

Shadows

Enable
Determines whether or not the color contributes to the gradient.

Color
Picks the color that the image will be colorized with. Select the desired color 

using the color picker.

Before After
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Position
Determines where the colorization is applied to the image. By default, Shadows 

are set to 0, which is the shadow areas. A value of 50 would be the midtones, 

while 100 would be highlights.

Midtones
The Midtones controls are the same as the controls for the Shadows, except by 

default, the colorization is applied to the midtones of the image.

Highlights
The Highlights controls are the same as the controls for the Shadows, except 

by default, the colorization is applied to the highlights of the image.

Grad
You can optionally use a gradient that limits where the plug-in is applied. Grad 

is the transition area that goes from the colorized image to the original image. 

Its direction, corners and size can be adjusted. Go to the Grad section of 

General Controls to see how the Grad controls work.
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 COLOR PASTE

Description
Color Paste takes the luminance values of the foreground image and pastes it 

as a color over the background.

Go to the Color Paste Tutorial to see how the plug-in works.

Opacity 
Sets the opacity of the foreground element.

Color
The Color parameter sets the color of the foreground image through the use of 

a standard eyedropper or color picker. The default color is white.

Background Foreground

Composite
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 COMPOSITE

Description
Composite layers a foreground over a background using a matte with the ability 

to add drop shadows. To create realistic composites, DVE, Color Correct, Blur 

and Grain controls are provided. Composite also lets you manipulate the matte 

using grow, shrink and blur tools. Another crucial feature in creating seamless 

effects, Composite's edge blending allows for color correction, blurring and 

controlling the opacity of the foreground images' edge.

Go to the Composite Tutorial to see how the plug-in works.

Matte
Selects what image to use for the matte.

Foreground

Background Matte

Composite
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Adobe After Effects
Choose the layer to use as the matte if you don’t have an embedded Alpha 

channel or if you want to use an Alpha channel from another clip.

Apple Final Cut Pro
Drag a clip from the timeline and drop it onto the clip icon to the right of the 

Matte parameter if you don’t have an embedded Alpha channel or if you want 

to use an Alpha channel from another clip.

Avid Editing Systems
When working with three tracks, the matte comes from the top track. When 

working with two tracks, the top track must contain a Matte Key (RGB+Alpha 

image) and it’s embedded alpha channel is used for the matte.

Opacity
Sets the opacity of the foreground element.

Matte
In this section, there are various controls that can be used to affect the matte. 

Go to the Matte section in the Matte Generator plug-in to see how the Matte 

controls work. The Matte Generator has a few extra matte controls, but cover 

everything that is included here.

Use
Chooses the channel from the matte input to use in the Composite.

Alpha Channel
The Alpha Channel is used for the matte in the composite.

Red Channel
The Red Channel is used for the matte in the composite.

Green Channel
The Green Channel is used for the matte in the composite.

Blue Channel 
The Blue Channel is used for the matte in the composite.
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Luminance
The average luminance of the RGB channels is used for the matte in the 

composite.

Note: The Use parameter is not available in Avid Editing Systems. When applied to a 
Matte Key, the Alpha Channel is used, otherwise it uses the luminance of the RGB 
channels.

Invert
Off
Does nothing to the matte.

On
Inverts the luminance values of the matte.

Note: Depending on what is black and white in your matte, you may need to toggle 
Invert to off. 

Shrink/Grow
Shrinks or grows the matte. Negative values shrink and positive values grow 

the matte.

Blur
The matte is blurred by a fast, quality blur. Go to the Blur plug-in to see how 

the Blur Controls work.

Clip
Black Clip
Blacks in the matte are made blacker by increasing the value of the slider. As 

the slider value increases, more values are clipped to black. This is helpful for 

getting rid of unwanted grey areas in what should be the black part of the matte.

White Clip
Whites in the matte are made whiter by increasing the value of the slider. As 

the slider value increases, more values are clipped to white. This is helpful for 

getting rid of unwanted grey areas in what should be the white part of the matte.
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Drop Shadow
Drop shadows can be added to any composite. All you have to do is turn up the 

opacity, position the drop shadow and add a little blur.

Note: The Drop Shadow parameter on Avid Systems has been truncated to “Shad”.

Color
The Color parameter sets the color of the drop shadow through the use of a 

standard eyedropper or color picker. The default color is black.

Opacity 
The opacity of the shadow.

Blur
The drop shadow is blurred by a fast, quality blur. Go to the Blur plug-in to see 

how the Blur controls works.

DVE
The drop shadow can be manipulated using the DVE. Go to the DVE plug-in to 

see how the DVE controls work.

Note: There are two sets of on-screen DVE controls in Composite. The point controls 
that are offset to the right and down are for the drop shadow, while the point controls 
located on the corners and center of the image are for the foreground. To see the on-
screen controls in After Effects, you must highlight the “Composite” effect title in the 
Effect Controls window. On Avid Editing Systems, you may need to zoom out to see the 
on-screen controls.

Composite w/out shadow Composite with shadow 
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Edge
The Edge parameters allow you to color correct or blur only the edge of the 

foreground. You can also mix the edge of the foreground with the background. 

This is very helpful for seamlessly integrating 3D elements as well as dealing 

with aliased mattes.

Size
Determines the size of the edge matte.

Color Correct
The edge of the foreground can be color corrected. Go to the Color Correct 

plug-in to see how Color Correct controls work.

Blur
The edge is blurred by a fast, quality blur. Go to the Blur plug-in to see how the 

Blur controls work.

Opacity
Mixes the foreground back to the background, but only in areas of the edge 

matte.

General Controls
Composite includes Color Correct, Blur, Grain and DVE controls. Go to the 

Color Correct, Blur, Grain and DVE plug-ins to see how they work.

Edge Matte
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 DEARTIFACT

Description
DeArtifact is handy for cleaning up artifacts caused by DV and HD video 

footage. In fact, it is useful for cleaning up images that have aliased or jaggy 

edges. 

When activated, a RGB to YUV conversion takes place so that you can blur 

only the U and V color channels. Since this is where most of the artifacting 

shows up, this has the effect of cleaning up the ratty edges encountered when 

keying DV or HD video footage. It is usually best to blur mostly on the horizontal 

axis.

Note: The DeArtifact parameters default to settings that are good for DV footage. If you 
are working at higher resolutions, you will want to increase the Blur settings.

Go to the DeArtifact Tutorial to see how the plug-in works.

DeArtifact
Activates DeArtifacting.

Horizontal Blur
The U and V color channels are blurred by a fast, quality blur along the X-axis.

Vertical Blur
The U and V color channels are blurred by a fast, quality blur along the Y-axis.

Before  After 
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Gang
The horizontal and vertical slider values can be ganged together.
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 DEFOCUS

Description
DeFocus replicates a true camera defocus by introducing lens Bokeh effects. 

Bokeh is the Japanese term that describes the quality of out-of-focus points of 

light. In defocused areas, each point of light becomes a shape--either a circle 

or a polygon. The shape grows in size as the amount of defocusing is 

increased.

Go to the DeFocus Tutorial to see how the plug-in works.

Warning: Large Matte > Range and Aperture > Size settings can cause the DeFocus 
filter to render slowly.

Blur
The image is blurred by using a quality blur.

Aperture
The Aperture settings control the various qualities of the out-of-focus points of 

light.

Before After
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Boost
Brightens the out-of-focus points of light.

Facets
Set the number of facets of out-of-focus points of light when the Curvature 

parameter is set to 0.

Curvature
Controls the curvature of out-of-focus points of light. When set to 100, the out-

of-focus points of light are completely round. Set to a value of 0 to see a 

polygonal shape.

Angle
Rotates the out-of-focus points of light.

Size
Sets the size of the out-of-focus points of light.

Blur
Blurs the out-of-focus points of light.

Noise
Noise is introduced into the out-of-focus points of light resulting in a more 

organic bokeh effect.

Density
Controls the brightness of the noise.

Threshold
Controls the amount of out-of-focus points of light. The higher the threshold 

value, the less out-of-focus points of light you will see.

Matte
A matte is used to create the defocus effect. Go to the Matte section in the 

Matte Generator plug-in to see how the Matte controls work.
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Time Average
In most cases, it is necessary to use an Time Average function on moving 

images. Otherwise, the Bokeh effects tend to flicker. Time Averaging allows for 

a very smooth matte, because pixel values from future frames are averaged 

together.
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 DEFOG

Description
Using advanced deweathering algorithms, DeFog restores clear day contrasts 

and colors of a scene taken in bad weather such as fog and mist. It is also 

successful in removing the effects of optical Fog and Diffusion filters.

Go to the DeFog Tutorial to see how the filter works.

DeFog

Color
The Color parameter sets the color of the fog to be removed through the use of 

a standard color picker. The default color is white.

Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 

to remove fog. By default, the vanishing point is set to the center of the screen. 

Essentially, the fog is removed in a radial pattern emanating from the vanishing 

point. So at the default center position, fog is removed in a circular pattern with 

a greater amount of fog being removed from the center while falling off at the 

edges. For instance, if your fog moves in the direction of top right to bottom left, 

set your vanishing point towards the top right corner and the fog removal will 

Before After
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be more intense at the upper right and fall off at the bottom left. However, in 

most cases, the vanishing point can be left in the center of the screen and you 

will obtain acceptable results.

There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the vanishing point can be 

adjusted.

Position X
The horizontal position of the vanishing point.

Position Y
The vertical position of the vanishing point.

Note: To see the on-screen control in After Effects, you may need to highlight DeFog 
in the Effect Controls window, and in Final Cut Pro and Combustion, you will have to 
click on the crosshair icon to the right of the vanishing point parameter. On Avid Editing 
Systems, the Vanishing Point parameters are named only X and Y.

DeFog
Sets the amount of fog to be removed from the scene.

Min Depth
Controls how much fog is removed from the darker areas of the image.

Max Depth
Controls how much fog is removed from the brighter areas of the image.

Color Correct
Go to the Color Correct plug-in to see how the Color Correct controls work.
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 DISTORTION

Description
Distortion corrects for pin-cushioning and barrel distortion of camera lenses. It 

is also useful for creating the look of a wide angle lens.

Go to the Distortion Tutorial to see how the plug-in works.

Barrel Distortion Pin Cushion Distortion

Original
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Controls

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 

image outward while positive values pull the corners of the image inward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 

picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 

anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been adjusted.

Center
Determines the center point for the distortion. There is an on-screen control in 

the center of the image. By clicking and dragging the on-screen control, the 

Center can be adjusted.

Before After
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 DROP SHADOW

Drop shadows can be added to an image that has an Alpha channel. The 

opacity color, blur and transformation of the drop shadow can all be adjusted.

Go to the Drop Shadow Tutorial to see how the plug-in works.

Color
The Color parameter sets the color of the drop shadow through the use of a 

standard eyedropper or color picker. The default color is black.

Opacity 
The opacity of the shadow.

Blur
The drop shadow is blurred by a fast, quality blur. Go to the Blur plug-in to see 

how the Blur controls work.

DVE
The drop shadow can be manipulated using the DVE. Go to the DVE plug-in to 

see how the DVE controls work.
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 DVE

Description
DVE allows you to transform your image using Position, Scale, Rotation, 
Corner-Pin, Shear and Crop controls. Why the name DVE? DVE is an acronym 
for digital video effects and refers to a real-time image manipulation device 
which does pans, rotations, flips as well as various hardware-specific effects 
such as page turns or customized wipes. In the film and video post production 
industry, DVE is frequently used in reference to transforming the image in some 
way.

Go to the DVE Tutorial to see how the plug-in works.

DVE
The DVE allows you to transform your foreground image using Position, Scale, 

Rotation, Corner-Pin, Shear and Crop controls.

Crop
Top
Crops the image from the top down.

Bottom
Crops the image from the bottom up.

Left 
Crops the image from left to right.

AfterBefore
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Right
Crops the image from right to left.

Corner-Pin
The image can be corner pinned by adjusting the Corner-Pin sliders as well as 

dragging the four points on the corners of the screen.

Note: You may need to zoom the image out a bit to see the Corner-Pin on-screen 
controls. In addition, to see and adjust the Corner-Pin on-screen controls in After 
Effects, make sure that the effect title in the Effect Controls window is highlighted. For 
Final Cut Pro and Combustion, you must activate the cross hair icon next to the corner 
position parameters to see and adjust the Corner-Pin on-screen controls.

Upper-Left
Controls the X and Y position of the Upper Left Point.

Upper-Right
Controls the X and Y position of the Upper Right Point.

Lower-Right
Controls the X and Y position of the Lower Right Point.

Lower-Left
Controls the X and Y position of the Lower Left Point.

There are four points around the four corners of the image. By clicking and 

dragging any of the four points, the image can be adjusted.

Position
Offset X
The horizontal position of the image.

Offset Y
The vertical position of the image.

Scale
Scale X
The horizontal scale of the image.
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Scale Y
The vertical scale of the image.

Gang Scale
The horizontal and vertical slider values can be ganged together.

Rotate
In addition to the standard position and scale controls, the image can be 

rotated. Positive values rotate clockwise and negative values rotate counter-

clockwise.

Shear
Shear X
Skews the image left and right.

Shear Y
Skews the image up and down.

Anchor
Anchor X
Defines the point on the X axis where the image will be positioned, rotated, 

scaled or sheared.

Anchor Y
Defines the point on the Y axis where the image will be positioned, rotated, 

scaled or sheared.
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 EDGE COMPOSITE

Description
Edge Composite automatically generates an edge matte from an existing Alpha 

channel and allows you to color correct or blur only the edge of the foreground. 

You can also mix the edge of the foreground with the background. This is very 

helpful for seamlessly integrating images as well as dealing with aliased mattes

Go to the Edge Composite Tutorial to see how the plug-in works.

Size
Determines the size of the edge matte.

Color Correct
The edge of the foreground can be color corrected. Go to the Color Correct 

plug-in to see how the Color Correct controls work.

Horizontal Blur
The edge of the foreground is blurred by a fast, quality blur along the X-axis, 

but only in areas of the edge matte.

Vertical Blur
The edge of the foreground is blurred by a fast, quality blur along the Y-axis, 

but only in areas of the edge matte.

Edge Matte Edge After
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Gang
The horizontal and vertical slider values can be ganged together. Adjust the 

horizontal slider to affect both values.

Opacity
Mixes the foreground back to the background, but only in areas of the edge 

matte.
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 FILM MASKS

Description
Film Masks aid you in determining what will be projected on film by adding 

reticles and or a variable opacity mask to the image. The following aspect 

ratio’s are supported: 2:40 Common Center, 2:40 Common Top, 1:85, 1:78, 

1:75, 1:66, 1:37 and the TV Transmitted Area, Safe Action and Safe Title for 

NTSC video. Film Masks is only available for Adobe After Effects and After 

Effects compatible programs.

Note: For the film masks to be of any use, you must find out the aspect ratio of 
your particular film in addition to whether Common Center or Common Top 
framing was used. The visual effect supervisor or cameraman will have this 
information. Also, the use of the Film Masks is limited to film shot with normal, 
spherical lenses. Do not use on film shot with anamorphic or squeezed lenses.

Go to the Film Masks Tutorial to see how the plug-in works.

Image
Indicate the size of the image you are using.

2048x1556
Select 2048x1556 if your image size is 2048x1556.

1828x1332
Select 1828x1332 if your image size is 1828x1332.
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Variable
Select Variable for image sizes other than 2048x1556 and 1828x1332.

Aperture
Indicates whether you are using either a Full Aperture or an Academy Offset 

frame.

Full
The Full Aperture frame is the total area between the 35mm perforations, 

including the area normally reserved for the sound track. Full Aperture is 

normally used for films shot in a Super 35mm with an aspect ratio of 2:40.

Academy Offset
Academy Offset refers to that area of the film frame excluding the sound track. 

Academy Offset is normally used on films shot in a 1:85 aspect ratio.

Note: Some people like to work with scans that are 1828x1332 at a1:85 aspect ratio. 
These scans already have the sound track removed from them and are smaller in size 
resulting in faster render times. To use the Film Masks plug-in with these images, you 
would select Full Aperture.

Common
• Common Center

Chooses Common Center framing. Most films use Common Center.

• Common Top

Chooses Common Top framing.

Aspect Ratio
The most prevalent film formats, or aspect ratios, are 1:85 and 2:40. These 

ratios are derived by dividing the width of the picture by the height.

2:40
Sets the mask to 2:40--usually used with the Super 35mm format.

1:85
Sets the mask to 1:85.
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1:66
Sets the mask to 1:66.

Variable
Chooses the aspect ratio with which to mask the image. The choices are: 1:37, 

1:66, 1:75, 1:78, 1:85, 2:40. 

The variable aspect ratio parameters can be used with any size frame, but depending 
on your image size, may not be an accurate representation of what you will see on film. 
The mask is created based on the image size and the aspect ratio that is selected.

TV Transmitted
Sets the mask to the NTSC TV Transmitted area.

TV Safe Action
Sets the mask to the NTSC TV Safe Action.

TV Safe Title
Sets the mask to the NTSC TV Safe Title.

Center
Turns a Center cross-hair on and off.

Masks/Reticle

Reticle/Text Opacity
Sets the opacity of the reticles and text.

Reticle/Text Color
The Color parameter sets the color of the reticles and text through the use of a 

standard eyedropper or color picker. Defaults to the color white.

Reticle Thickness
Sets the thickness of the reticles.

2.40 Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.
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1.85 Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

1.66 Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

Variable Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

TV Transmitted Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

Mask Color
The Color parameter sets the color of the mask through the use of a standard 

eyedropper or color picker. Defaults to the color black.
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 FRAME AVERAGER

Description
The Frame Averager mixes frames together to create interesting motion 

effects. This plug-in is also useful for smoothing out film grain and video noise 

which can cause problems when pulling a key or generating a matte.

Go to the Frame Averager Tutorial to see how the plug-in works.

Frames
Sets the amount of frames after the current frame to be blended.

AfterBefore
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 GLOW EDGES

Description
Glow Edges isolates lines and edges in an image and then adds glow only to 

these areas resulting in a stylized look.

Go to the Glow Edges Tutorial to see how the plug-in works.

Glow

Blend
Determines the blend mode to be used to create the edge glow effect.

Add
The edge glow is added to your image.

Screen
The edge glow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Before After
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Brightness
Sets the intensity of the edge glow.

Blur
Sets the softness of the edge glow.

Color
The Color parameter sets the color of the edge glow through the use of a 

standard color picker. The default color is white.

Edge
An edge matte is created to produce the edge glow effect.

Brightness
Determines the brightness of the edge matte.

Blur
Blurs the edge matte.
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 GLOW EFFECTS

Description
Glow Effects creates diffusion or glows around selected areas of the image.

Go to the Glow Effects Tutorial to see how the plug-in works.

Copyright © 2008--www.iofoto.com
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Glow

Blend
Determines the blend mode to be used to create the diffusion/glow effect.

Add
The diffusion/glow is added to your image.

Normal
Diffusion is mixed with the original image. In this mode, the Amount parameter 

only shows changes up to a value of 100.

Screen
The diffusion/glow is combined with the image using a Screen blend mode. 

This looks kind of like the Add blend mode, but highlights are retained.

Amount
Sets the amount of the diffusion/glow.

Blur
Sets the softness of the diffusion/glow.

Color
The Color parameter sets the color of the diffusion/glow through the use of a 

standard Color Picker or Eyedropper. The default color is white.

Note: Color has no effect when using the Normal blend mode.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Matte
In some of the plug-ins, a matte is generated to create the desired effect--in this 

case, diffusion and glows.
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Position
When using the Add and Screen blend modes, Position selects the values used 

to create the diffusion/glow effect. A higher Position value uses the brightest 

image values to create the diffusion/glow. A lower Position value uses the 

darkest image values to create the glow.

Range
When using the Add and Screen blend modes, Range controls the range of 

values to be used for the diffusion/glow. Once you’ve selected the Position, you 

can then add or subtract the Range of values to be used in the diffusion/glow 

source. A higher Range value includes more values in the diffusion/glow source 

while a lower Range value includes less values.

Blur
The matte is blurred by a fast, quality blur.
mposite Suite Pro User Guide



• 

Grain  97 

• 
• 
• 
•
•
•

 GRAIN

Description
Grain simulates film grain with individual control of red, green, and blue grain 

size and intensity. In addition, a Film Response parameter controls where you 

will see grain in the image. Popular film stock presets are provided as a starting 

point to adding grain.

Go to the Grain Tutorial to see how the plug-in works.

Presets
Select one of the many film grain presets from the pop-up list.

Note: On Avid Editing Systems, the Grain parameters are deactivated when a preset 
has been selected.

Monochrome
When checked, the grain is monochrome. In this mode, only the Red Size, Red 

Amount and Red Softness sliders are active. Since the grain is monochrome, 

only one slider is needed.

Before After
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Size
The Size parameters control the size of the grain. Sometimes a film stock’s 

grain structure varies in size from one color channel to another, so individual 

control has been given. The larger the Size settings, the larger the grain will be.

Red Size
Controls the size of the red grain.

Green Size
Controls the size of the green grain.

Blue Size
Controls the size of the blue grain.

Amount
The Amount parameters set the red, green and blue intensities of the grain. 

Film stocks generally have varying amounts of red, green and blue intensities 

with the blue intensity generally higher than the rest. If you turn the red, green 

and blue amount sliders to a value of 0, the grain will disappear.

Red Amount
Controls the intensity of the red grain.

Green Amount
Controls the intensity of the green grain.

Blue Amount
Controls the intensity of the blue grain.

Softness
The Softness parameters control the softness of the grain. Some film stock’s 

grain structure varies in softness from one color channel to another, so 

individual control has been given. Normally, only minor softness adjustments 

are necessary, usually between a value of 0-1.
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Red Softness
Controls the softness of the red grain.

Green Softness
Controls the softness of the green grain.

Blue Softness
Controls the softness of the blue grain.

Film Response
The Film Response parameter allows the adjustment of where you will see 

grain in the image. In most cases, film grain is apparent over the entire image 

except the brightest whites with the black areas being the most affected.

Position
The Position slider defines the portions of the image where grain will be added. 

A low Position value places grain in the darkest image values, while a high 

Position value places grain in the brightest areas.

Range
Increases or decreases the area where grain is added to the image based on 

the value of the Position slider. A low Range value indicates a narrow range of 

values, while a high Range value indicates a large range of values.

Minimum
Sets the minimum level of grain that is always added to the image.

Note: A Position value of 0 and a Range of 80 is typical of standard film, with grain 
applied to the entire range except the brightest whites with black being the most 
affected.
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 HDTV MASKS

Description
If your HD images are destined to end up on film, the HDTV Masks plug-in aids 

you in determining the portion of the HDTV frame that will be projected on film 

by adding reticles and or a variable opacity mask to the image. The following 

aspect ratio’s are supported: 1:85 and the TV Transmitted Area, Safe Action 

and Safe Title for NTSC video. HDTV Masks are not available for Avid Editing 

Systems.

Go to the HDTV Masks Tutorial to see how the plug-in works.

Note: The HDTV Masks plug-in should only be used on 1920x1080 HDTV images.

Aspect Ratio
The most prevalent aspect ratio when transferring HD to film is 1:85.

1:85
Sets the mask to 1:85.

TV Transmitted
Sets the mask to the NTSC TV Transmitted area.

TV Safe Action
Sets the mask to the NTSC TV Safe Action.

TV Safe Title
Sets the mask to the NTSC TV Safe Title.

Before After
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Center
Turns a Center cross-hair on and off.

Note: The positioning of the NTSC TV Transmitted Area for HDTV has not been 

standardized as of yet. Therefore, we have positioned the TV Transmitted Area in the 

center of the HD frame. 

Masks/Reticle

Reticle/Text Opacity
Sets the opacity of the reticles and text.

Reticle/Text Color
The Color parameter sets the color of the reticles and text through the use of a 

standard eyedropper or color picker. Defaults to the color white.

Reticle Thickness
Sets the thickness of the reticles.

1.85 Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

Variable Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

TV Transmitted Opacity
Sets the opacity of the mask. Everywhere outside of the mask is blocked by the 

color black.

Mask Color
The Color parameter sets the color of the mask through the use of a standard 

eyedropper or color picker. Defaults to the color black.
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 HOLDOUT COMPOSITE

Description
To add practical fire, explosions, smoke or other footage not containing an 

Alpha channel is normally a challenge. A normal Math Composite Add function 

would cause areas of the background to get brighter. This is bad. Using a key 

of some type would most likely generate unwanted edge fringing. This is also 

bad. The Holdout Composite is a two-layer/track effect that effectively 

composites images such as fire, explosions and smoke. This plug-in first 

creates a luminance matte of the foreground and pastes it as black (or other 

color) over the background. You then use one of the Blend Modes to place the 

foreground over the “held out background”. 

Go to the Holdout Composite Tutorial to see how the plug-in works.

Background
Selects what image to use as the background.

Adobe After Effects
Choose the layer to use as the background. 

Composite

Background Foreground
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Apple Final Cut Pro
Drag a clip from the timeline and drop it onto the clip icon to the right of the 

Background parameter.

Avid Editing Systems
The track below the current track is automatically used as the background.

Blend
This selects the type of Math Composite to use for the foreground element. Go 

to the Blend section in the Math Composite plug-in to see visual examples of 

the different Blend modes.

Add
The pixels of the foreground are added to the background.

Screen
The foreground and background are combined using a Screen blend mode. 

This looks kind of like the Add blend mode, but highlights are retained.

Lighten
Compares the foreground and background and takes the pixels with the higher 

value.

Level
Sets the level of the foreground element.
Composite Suite Pro User Guide    
• 
• 
•
•
•



   Co

104 Holdout Composite

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Black Clip
Blacks are made blacker by increasing the value of the slider. As the slider 

value increases, more values are clipped to black.

Note: Often times the black portion of an image is not entirely black. This becomes an 
issue if something like fire is shot against a black background. If the black is not entirely 
black, then these impure black areas will be added to the background image as part of 
the Holdout Composite causing the final result to have milky blacks. Black Clip will 
improve these milky blacks and make them darker.

Matte
The Holdout Composite first creates a luminance matte of the foreground and 

then pastes it as black (or other color) over the background. You can see the 

extracted matte with the View set to Matte.

Black Clip
Blacks in the matte are made blacker by increasing the value of the slider. As 

the slider value increases, more values are clipped to black. This is helpful for 

getting rid of unwanted grey areas in what should be the black part of the matte.

White Clip
Whites in the matte are made whiter by increasing the value of the slider. As 

the slider value increases, more values are clipped to white. This is helpful for 

getting rid of unwanted grey areas in what should be the white part of the matte.

Matte
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Holdout
The Holdout Composite takes the luminance matte of the foreground and 

pastes it as black (or other color) over the background. You can see the matte 

pasted onto the background with the View set to Holdout.

Color
The Color parameter sets the color of the Holdout matte through the use of a 

standard eyedropper or color picker. The default color is black.

Note: There may be times when you want to select a color from the background as the 
Holdout color. This will appear to give the foreground some atmosphere.

Opacity 
The opacity of the color.

Matte Background Paste Color
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 LIGHT / GOBO

Description
Light can be added to a scene where none existed before just as if you were 

adding light at the time of shooting. Realistic lighting and shadow is introduced 

using digital versions of the entire gobo libraries created by Gamproducts for 

the Light filter and Rosco for the Gobo filter. 

Patterns, or gobos, are widely used by designers in theatre, film, photography 

and television to create atmosphere, project scenery, and generally enhance 

the visual impact of their lighting. Normally used in front of lights during 

photography, these same exact patterns can be applied digitally to the entire 

image or inside a matte.

Before After
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Gamproducts Gobos
The Gamproducts line of gobos includes 565 designs to choose from including 

Blendables, Breakups, Christmas, Cityscapes & Towns, Clouds, Fences & 

Openings, Fire & Water, Flags, Flowers, Foliage, Holidays & Symbols, Moons, 

Natural Elements, Religion, Signage, Sky & Stars, Spirals, Spotlights & 

Pinspots, Stones & Brick, Structures & Sets, Themes, Trees and Vignettes & 

Windows.
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Rosco Gobos
The Rosco range presently includes over 1300 standard gobo designs in the 

following categories: Breakups, Foliage Breakups, Trees & Flowers, Abstract, 

Graphics, Graphics & Grills, Rotation, Symbols & Signs, World Around Us, 

Churches & Heraldics, Windows, Doors & Blinds, Boundaries & Wildlife, 

Clouds & Sky, Water & Sky, Fire & Ice, Architectural & Retail, Occasions & 

Holidays and Text.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whether they want to create a romantic moonlit setting or 

a vicious, angry fight, they have the colors they need to achieve the effect. 

Digital equivalents of the lighting gels created by Gamproducts and Rosco can 

also be applied to the light source. 

For detailed information about Gamproducts and Rosco gobos and gels, you 

can visit their websites at www.gamonline.com and www.rosco.com. 
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Go to the Light / Gobo Tutorial to see how the filters work.

Note to Avid Users: Light and Gobo are two track effects and must be applied to the 
upper track. The upper track is used as the lighting source. If you want to use one 
image to add light to itself, just place the same image on two adjacent tracks.

Light

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Subtract
The light is subtracted from your image creating shadow instead of light.

Brightness
Sets the intensity of the light.
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Displacement
Displaces the gobo by the luminance values of the image. This fakes the effect 

of light wrapping over objects in the image.

Blur
Sets the softness of the light.

Gels
Digital equivalents of the lighting gels created by Gamproducts and Rosco can 

be applied to the light source. Light uses GamColor gels and Gobo uses Rosco 

gels. Select one of the gel presets from the pop-up list.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Gels pop-up menu.

Shadow

Brightness
Sets the intensity of the shadows. The Brightness parameter will darken only 

those areas that are not being affected by the Light settings. 

Displaced Gobo
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Matte
A matte can be used to create areas of light or limit where gobos will be added. 

Wherever there is white in the matte is where the light will be added. When 

using the Light and Gobo filters, it is usually helpful to blur the matte. Go to the 

Matte section in the Matte Generator plug-in to see how the Matte controls 

work.

Note: To use a matte to create light, the Gobo > Blend Mode must be set to something 
other than Gobo Only for the Matte controls to be active. In addition, if you set Gobo > 
Category to None, you can use the Matte to create light instead of using a gobo.

Gobos

Category
The gobos are organized into different categories. To select different gobos, 

make a choice in the Gobo > Category pop-up menu and then pick the desired 

gobo within the selected group.

Gamproducts Gobo Categories
Series 200, 300, 500, 600, 700 and 800.

Matte
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Rosco Gobo Categories
Breakups, Foliage Breakups, Trees & Flowers, Abstract, Graphics, Graphics & 

Grills, Rotation, Symbols & Signs, World Around Us, Churches & Heraldics, 

Windows, Doors & Blinds, Boundaries & Wildlife, Clouds & Sky, Water & Sky, 

Fire & Ice, Architectural & Retail, Occasions & Holidays and Text.

None
With None selected, only the Matte is used to create light.

Input
Input allows you to use a custom image as the light source.

Note: You must first select Input from the Category pop-up menu before you can use 
a custom image as the light source.

To use an image as a light source in:

Adobe After Effects
• Select Input from the Gobo > Category menu. 

• Select a layer from the Gobo > Input menu. 

Apple Final Cut Pro
• Select Input from the Gobo > Category menu.

• Drag and drop a clip onto the clip icon to the right of the Gobo > Input parameter.

Avid Editing Systems
• Select Input from the top most pop-up in the Gobo group. 

• The track that you added the Light or Gobo filter to is now used as the light source 
and applied to the track below. 

Note: If the camera is moving and you want to add a gobo, the gobo won’t 
automatically follow the camera. You will either need to manually move the gobo to 
follow the camera or better, use Motion Tracking software to Match Move the gobo to 
the camera move. Track the motion of your source image, set your View to Gobo, apply 
the tracker motion to your gobo and render it. To use the newly tracked and rendered 
gobo as a light source, follow the previous instructions listed for using a custom image 
as the light source.

Blend Mode
The gobo can be added to a matte using a variety of Blend modes. Go to the 

Blend section in the Math Composite plug-in to see visual examples of the 

different Blend modes.
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I like the Multiply blend mode for combining gobos with the matte because it 

only puts the gobo within the areas of the matte.

Opacity
Sets the opacity of the gobo.

Matte Gobo

Multiply
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Blur
Sets the softness of the gobo.

DVE
The DVE allows you to transform your gobo using Position, Scale, Rotation, 

Corner Pin, Shear and Crop controls. Go to the DVE plug-in to see how the 

DVE controls work.

Shape Blur=20
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 LIGHT WRAP

Description
Light Wrap helps blend the foreground into the background by making the color 

of the background wrap into the foreground edges without softening the edge. 

This is accomplished by placing the background layer into a special matte and 

then combining it with the foreground. You can look at the Light Wrap element 

in the View menu.

Go to the Light Wrap Tutorial to see how the plug-in works.

Background
Selects what image to use as Light Wrap source.

Adobe After Effects
Choose the layer to use as the Light Wrap source.

Before After

Light Wrap SourceForeground Matte
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Apple Final Cut Pro
Drag a clip from the timeline and drop it onto the clip icon to the right of the 

Background parameter.

Avid Editing Systems
The track below the current track is automatically used as the Light Wrap 

source.

Light
Sets the intensity of the Light Wrap.

Wrap
Sets the size of the Light Wrap.
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 MATH COMPOSITE

Description
Math Composite combines two clips using one of the Blend modes. You can 

choose from Add, Subtract, Multiply, Screen, Difference, Darken and Lighten.

Go to the Math Composite Tutorial to see how the plug-in works.

Background
Selects what image to use as the background.

Adobe After Effects
Choose the layer to use as the background. 

Apple Final Cut Pro
Drag a clip from the timeline and drop it onto the clip icon to the right of the 

Background parameter.

Avid Editing Systems
The track below the current track is automatically used as the background.

Composite

Background Foreground
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Blend
Selects the Blend mode that is used to combine the foreground and 

background.

Add
The pixels of one image are added to another image.

Subtract
The pixels of one image are subtracted from another image.

Multiply
Produces a result where there is a union of pixels from two images.

Background                  Foreground                        Result

Background                  Foreground                        Result

Background                  Foreground                        Result
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Screen
Looks at each images color information and multiplies the inverse of the two 

images. This looks kind of like the Add blend mode, but highlights are retained.

Difference
Produces a result where a value exists in each image, but not in both.

Darken
Compares two images and takes the pixels with the lower value.

Background                  Foreground                        Result

Background                  Foreground                        Result

Background                  Foreground                        Result
Composite Suite Pro User Guide    
• 
• 
•
•
•



   Co

120 Math Composite

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Lighten
Compares two images and takes the pixels with the higher value.

Level
Sets the level of the foreground element.

Black Clip
Blacks are made blacker by increasing the value of the slider. As the slider 

value increases, more values are clipped to black.

Note: Often times the black portion of the image is not entirely black. This becomes an 
issue if something like fire is shot against a black background. If the black is not entirely 
black, then these impure black areas will be added to the background image as part of 
the Math Composite causing the final result to have “milky” blacks. The Black Clip 
parameter has been added to easily adjust the foreground image’s black level.

Background                  Foreground                        Result
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 MATTE GENERATOR

Description
The Matte Generator extracts and creates mattes using advanced matte 

extraction techniques. Methods of matte extraction are luma, hue, saturation, 

average, red, green, blue, cyan, magenta, and yellow. Up to 5 mattes can be 

extracted and combined using Blend modes.

Go to the Matte Generator Tutorial to see how the plug-in works.

Matte 1
A matte is extracted to isolate areas of the image.

Before

After
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Extract On
Extract On selects the type of matte extraction. Select whichever type isolates 

the desired values. A matte is extracted based on one of the following:

• Luminance

A matte is extracted based on the luminance of the image.

• Hue

A matte is extracted based on the hue of the image. When adjusting the 

Position parameter, you are selecting different hues.

• Saturation

A matte is extracted based on the saturation of the image.

• Average

A matte is extracted based on the average of the image’s RGB values.

• Red

A matte is extracted based on the image’s red values.

• Green

A matte is extracted based on the image’s green values.

• Blue

A matte is extracted based on the image’s blue values.

• Alpha

A matte is extracted based on the image’s alpha values.

• Cyan

A matte is extracted based on the image’s cyan values.

Hue Extraction
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• Magenta

A matte is extracted based on the image’s magenta values.

• Yellow

A matte is extracted based on the image’s yellow values.

Warning: Some matte extraction types may yield a noisy matte. For instance, the blue 
channel from film originated images contains most of the image’s grain.

Position
The Position value pinpoints the color values to be used in the matte. For a 

luminance extraction, a Position value of 100 would make a white matte of the 

highlights and a value of 0 would make a white matte of the shadows. In our 

flower image, look at how the matte varies for different Position values in a red 

matte extraction. When the Position is at a value of 100, the red flowers are 

shown as white in the matte.

When the Position is moved to 50, the red flowers turn black.

Position=100, Range=25

Position=50, Range=25
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Range
Increases or decreases the range of values in the matte. A low Range value 

indicates a narrow range of values. A high Range value indicates a large range 

of values included in the matte.

Black Clip
Blacks in the matte are made blacker by increasing the value of the slider. As 

the slider value increases, more values are clipped to black. This is helpful for 

getting rid of unwanted grey areas in what should be the black part of the matte.

Position=100, Range=50

 Matte with No Black Clip                                 Black Clip=50
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White Clip
Whites in the matte are made whiter by increasing the value of the slider. As 

the slider value increases, more values are clipped to white. This is helpful for 

getting rid of unwanted grey areas in what should be the white part of the matte.

Shrink/Grow
Shrinks or grows the matte. Negative values shrink and positive values grow 

the matte.

 Matte with No White Clip                                 White Clip=50

Original

                    Shrink=-2                                              Grow=1.5
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Blur
The matte is blurred by a fast, quality blur. Go to the Blur plug-in to see how 

the Blur controls work.

Wrap
Wrap retains the definition of the matte edges while creating a smooth blend of 

transparency starting at the edge of the matte changing to fully opaque moving 

inward.

No Blur                                                   Blur=10 

No Wrap                                                 Wrap=15 
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Invert
• Off

Does nothing to the matte.

• On

Inverts the luminance values of the matte.

Matte’s 2-5
Up to five mattes can be extracted and combined. After extracting the first 

matte, extract new mattes with the controls in Matte sections 2-5 and choose 

the Blend mode by which they will be combined. Matte’s 2-5 share similar 

controls, so they will only be described once.

Blend
Once selected, this newly generated matte can be combined with the 

previously generated matte. Go to the Blend section in the Math Composite 

plug-in to see visual examples of the different Blend modes.

Note: You must first choose a Blend mode in Matte’s 2-5 before they can be displayed 
in the View menu or contribute to the final matte.

Level
Sets the level of the matte element.

The remaining parameters for Matte’s 2-5 are the same as Matte1: Extract On, 

Position, Range, Clip, Shrink/Grow, Blur, Wrap and Invert.

Invert Off                                                 Invert On
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 MATTE REPAIR

Description
Matte Repair grows, shrinks or blurs a matte. It also is handy for cleaning up 

impurities in the black or white areas. Matte Repair has the same functionality 

as Matte Generator except it doesn’t have any parameters dealing with matte 

extraction.

Go to the Matte Repair Tutorial to see how the plug-in works.

Use
Chooses the channel from the input image to use for the Matte Repair.

Red Channel
The Red Channel is used for the Matte Repair.

Green Channel
The Green Channel is used for the Matte Repair.

Blue Channel 
The Blue Channel is used for the Matte Repair.

AfterBefore
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Luminance
The average luminance of the RGB channels is used for the Matte Repair.

Note: The Use parameter is not available in Avid Editing Systems. When applied to a 
Matte Key, the Alpha Channel is used, otherwise it uses the luminance of the RGB 
channels.

Matte
Go to the Matte section in the Matte Generator plug-in to see how the Matte 

controls work.
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 NON-ADDITIVE MIX

Description
Known as a NAM, the non-additive mix combines two pictures by controlling 

their luminance level relative to each other as well as a set mix percentage. 

This popular video switcher effect has been included to satisfy those die-hard 

online video editors.

Go to the Non-Additive Mix Tutorial to see how the plug-in works.

Background
Selects what image to use as the background.

Adobe After Effects
Choose the layer to use as the background. 

Background Foreground

Partial Mix
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Apple Final Cut Pro
Drag a clip from the timeline and drop it onto the clip icon to the right of the 

Background parameter.

Avid Editing Systems
The track below the current track is automatically used as the background.

Mix
Sets the mix level of the foreground element.

Black Clip
Blacks are made blacker by increasing the value of the slider. As the slider 

value increases, more values are clipped to black.

Note: Often times the black portion of an image is not entirely black. This becomes an 
issue if something like fire is shot against a black background. If the black is not entirely 
black, then these impure black areas will be added to the background image as part of 
the Non-Additive Mix causing the final result to have “milky” blacks. The Black Clip 
parameter has been added to easily adjust the foreground image’s black level.
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 OPTICAL DISSOLVE

Description
Optical Dissolve uses a power function to simulate an optical film dissolve. You 

see the bright areas of the B side of the dissolve sooner than the darker areas.

Go to the Optical Dissolve Tutorial to see how the plug-in works.

Opacity
Sets the mix level of the foreground element.

A-Side B-Side

Partial Dissolve
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 OZONE

Description
The Ozone filter allows you to manipulate the color of an image with incredible 

flexibility and accuracy. Inspired by Ansel Adams’ Zone System for still 

photography, we have created “The Digital Zone System”. Just what is the 

Digital Zone System? The world around us contains an infinite palette of colors, 

tones and brightness. To reproduce this vast range of brightness, the Digital 

Zone System takes the spectrum of image values and divides them into 11 

discrete zones using proprietary image slicing algorithms. Zones can be 

created using luminance, hue, saturation, average, red, green, blue, cyan, 

magenta, and yellow values. Look at how the image below is divided into hue 

zones. 

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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With Ozone, the color values of each zone can be independently adjusted until 

you’ve painted a new picture. Your adjustments occur on a zone by zone basis, 

but you view the result of all color corrections simultaneously.

Go to the Ozone Tutorial to see how the plug-in works.

Extract On
The Extract On pop-up menu allows you to specify the image values to be used 

for dividing the image into the 11 individual zones.

Luminance
Zones are created using the image’s luminance values.

Hue
Zones are created using the image’s hue. When adjusting the Position 

parameter, you are selecting different hues.

Saturation
Zones are created using the image’s saturation values.

Average
Zones are created based on the average of the image’s RGB values.

Before After

Copyright © 2008--www.iofoto.com
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Red
Zones are created using the image’s red values.

Green
Zones are created using the image’s green values.

Blue
Zones are created using the image’s blue values.

Cyan
Zones are created using the image’s cyan values.

Magenta
Zones are created using the image’s magenta values.

Yellow
Zones are created using the image’s yellow values.

Zone Controls
When using Luminance as the method for slicing up the image, the Position 

and Range sliders are preset so that each zone is twice as bright as the 

previous zone, proceeding from black towards white.

Pure black is defined as Zone 0, Zone 5 as middle gray and pure white as Zone 

10. By using the View menu, you can look at the zone which is helpful in 

determining the portions of the image you are going to adjust. The values 

shown as white in the selected zone are the areas of the image that will be 

modified by the color adjustments.

Go to the Matte section in the Matte Generator plug-in to see how the Position 

and Range controls work.

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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Position
The Position value pinpoints the color values to be used in the selected zone. 

This value has been preset according to the Digital Zone System, but can be 

changed if you choose. If the zones are created using Luminance, a high 

Position value shows the brightest image values as white values in the zone. A 

low Position value shows the darkest image values as white values in the zone.

Range
The Range value increases or decreases the range of values in the selected 

zone. This value has been preset according to the Digital Zone System, but can 

be changed if you want.

Hue
Rotates the hue of the zone.

Saturation
Adjusts the saturation of the zone. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the zone. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the zone. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the zone. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the zone.

Green
Adds or subtracts green from the zone.
mposite Suite Pro User Guide



• 

Ozone  137 

• 
• 
• 
•
•
•

Blue
Adds or subtracts blue from the zone.

Temperature
Sets the color temperature of the zone. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).
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 SELECTIVE COLOR CORRECT

Description
Colors can be selectively isolated through the use of a matte and adjusted 

using hue, saturation, brightness, gamma, contrast, red, green, and blue 

controls.

Go to the Selective Color Correct Tutorial to see how the plug-in works.

Color Controls
Certain parts of the image are isolated by the creation of a matte. Whatever is 
shown as white in the matte can be adjusted by the color controls below. 

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Before

After
mposite Suite Pro User Guide



• 

Selective Color Correct  139 

• 
• 
• 
•
•
•

Brightness
Adjusts the luminance of the entire image. Positive values brighten, negative 

values darken.

Contrast
Adjusts the contrast of the entire image. Positive values increase contrast, 

negative values decrease contrast.

Gamma 
Adjusts the gamma of the entire image. The gamma adjustment leaves the 

white and black points the same and only modifies the values in-between. 

Positive values darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Matte
A matte is extracted to isolate areas to be color corrected. Go to the Matte 

section in the Matte Generator plug-in to see how the Matte controls work.
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 TITLE BLUR

Description
This Avid only plug-in blurs your titles with individual horizontal and vertical 

controls and composites the result over the track below. It’s fast and high 

quality.

Go to the Title Blur Tutorial to see how the plug-in works.

Blur

Horizontal Blur
The title is blurred by a fast, quality blur along the X-axis.

Vertical Blur
The title is blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. Slide the 

horizontal slider to affect both values.

AfterBefore
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	1.85 Opacity
	Variable Opacity
	TV Transmitted Opacity
	Mask Color


	Holdout Composite
	Description
	Background
	Adobe After Effects
	Apple Final Cut Pro
	Avid Editing Systems

	Blend
	Add
	Screen
	Lighten

	Level
	Black Clip
	Matte
	Black Clip
	White Clip

	Holdout
	Color


	Light / Gobo
	Description
	Gamproducts Gobos
	Rosco Gobos
	Gels

	Light
	Blend
	Brightness
	Displacement
	Blur
	Gels
	Color

	Shadow
	Brightness

	Matte
	Gobos
	Category
	Blend Mode
	Opacity
	Blur
	DVE


	Light Wrap
	Description
	Background
	Adobe After Effects
	Apple Final Cut Pro
	Avid Editing Systems

	Light
	Wrap

	Math Composite
	Description
	Background
	Adobe After Effects
	Apple Final Cut Pro
	Avid Editing Systems

	Blend
	Add
	Subtract
	Multiply
	Screen
	Difference
	Darken
	Lighten

	Level
	Black Clip

	Matte Generator
	Description
	Matte 1
	Extract On
	Position
	Range
	Black Clip
	White Clip
	Shrink/Grow
	Blur
	Wrap
	Invert

	Matte’s 2-5
	Blend
	Level


	Matte Repair
	Description
	Use
	Red Channel
	Green Channel
	Blue Channel
	Luminance

	Matte

	Non-Additive Mix
	Description
	Background
	Adobe After Effects
	Apple Final Cut Pro
	Avid Editing Systems

	Mix
	Black Clip

	Optical Dissolve
	Description
	Opacity

	Ozone
	Description
	Extract On
	Luminance
	Hue
	Saturation
	Average
	Red
	Green
	Blue
	Cyan
	Magenta
	Yellow

	Zone Controls
	Position
	Range
	Hue
	Saturation
	Brightness
	Contrast
	Gamma
	Red
	Green
	Blue
	Temperature


	Selective Color Correct
	Description
	Color Controls
	Hue
	Saturation
	Brightness
	Contrast
	Gamma
	Red
	Green
	Blue

	Matte

	Title Blur
	Description
	Blur
	Horizontal Blur
	Vertical Blur
	Gang



